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Introduction

The purpose of this document is to guide students, staff and faculty on how to:
e Login into the newsroom machines
e Use Adobe premiere pro editing software to:
o Ingest rushes from smartphones
o Ingest rushes from Reuters and AFP news agencies
o Export edited rushes to EVS
e |ngest and export image to Chyron graphics system
e Use A|P ENPS news gathering software to:
o Create and publish rundowns in ENPS

Prerequisites
None
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SECTION 01- Logging into newsroom machine

The username and password for all the newsroom machines is available on the label, which
can be located as shown in the picture below.

For instance, the newsroom machine 1 credentials are:
Username: newsl
Password: NUQ®@123

Note: For operational convenience, the password is same for all the newsroom machines.

N _I85%

NORTHWESTERN

UNIVERSITY
IN QATAR

Each workstation is equipped with a:
e Adobe Premier Pro logical keyboard
e Scroll control mouse
e Sony professional dynamic stereo headphones
The newsroom is equipped with a A4 printer directly attached to the newsroom 1 machine.
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SECTION 02- Launching Adobe Premier Pro 2019
Opening the default adobe project in desktop

located on the desktop.

Please save your project and all associated files to your folder in Isilon.
All locally stored files will be permanently removed after each use.

Any technical difficulties?
Reporting an issue with the device or the room?
Please email

Note: If prompted for sign-in, login with your Adobe ID credentials.

Adobe Premiere pro will launch with the Production defined default layout and settings

~ A 00:00:00:00

o
+
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Moving Adobe projects from one user to another

Note: Existing Adobe projects can be accessed in the “Users” folder. If you have saved a project in a

different newsroom workstation, you can copy it to your respective machine.

1. Double click “This PC” icon in the desktop

2. Open the mapped network drive “Users”

([ This PC = o X
T sort 8= View
4 > ThisPC > v C Search This PC

~ v Quick access Folders (6)

T Desktop Documents Downloads Music Pictures
M Desktop : " S

L Downloads

g videos
5 Documents > ]
I Pictures Devices and drives (1)
Adobe Projects ] 05 (C:)
DOHA _— 218 GB free of 952 GB

Network locations (4

Reuters

Users. Virtual Studio User Ingest Ingest Felders (\\camiedb) (Z:)

VIDEOWALL IMAG || oy (\\news.localisilon.broadcast.qata.. (\news localisilon broadcast.qata.. g (\newslocalisilon broadcastata...
I I — M 6.76 TB free of 6,79 T8
> @ OneDrive
Users (\\news.localisilon.broadcast.qatar private\News) (L)
Space free: 243
> [ This PC Total size: 648 TB
> 3 Network

3. Navigate to the desired user folder to copy the project to your user folder.
For instance, the picture below shows copying a project from news2 user to the news1
user folder

o= Users (\\news.localisilon. broadc ast.qatar private\News) (U:) - 0O X
@ New N sore = view
€ v 4 > ThisPC > Users (Wnewsdocealisilon broadeast.qatar, private\News) (Us) > v C Search Users (\\news.localisilon,broadcast.qatar.private.
Name Date modified Trpe Size
v ¢ Quick access
administrator File folder
M Desktop
Adobe Cache-ITP File folder
- Downloads
Adobe Premiere Pro Aute-Save File folder
= Documents
Adobe_Icons_Do_Not Delete_For_Group_... File folder
PN Pictures
AdobeProjects-ITP File folder
Adobe Projects
DesktopBackground File folder
Reuters
news File folder
VIDEOWALL_IMAG
news? File folder
Windows11-Deskts
news3 File folder
> @ OneDrive newsd File folder
> B ThisPC news3 File folder
newsé File folder
> & Network
news? File folder
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4. Copy from the desired user folder to the current user folder

Saving an Adobe project

1. Navigate to File then click on Save As:
2. Name your Project using your Name, Project Name and Date

For instance: John Smith Reporting 9-aug-2022 (location will be set as default in
News folder >> Adobe Projects) and click Save

Thumbnall  Title

Newsroom
class1 07062022
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SECTION 03- Ingesting videos (Rushes) to EVS

From smartphones

1. Plug your smartphone to the computer with a USB cable.

Note: If prompted, allow access for USB file transfer and storage access from the smartphone.

2. Double click “This PC” icon in the desktop

3. Make sure the smartphone is visible in the explorer

v+ Quick access Folders (6)

; B Deskiop M1 Documents Downloads B Music Pictures
@l Desktop ‘ ~
= J |
4 Downloads
B Videos

] Documents L
1N Pictures Devices and d

Adobe Projects. w.‘ - 05 (C)

3| Apple iPhone o
Reuters il 818 GE free of 052 GB

VIDEOWALL MAC . UeTWOTR T0CaTone 7

Virtual Studio User Ingest Ingest Felders (\\camiodb) (Z:)

Users
Windows11-Desk  puy (\\news.localisilon.broadcast.qata...  puy (\\newslocalisilon.broadcast.qata... ey localisilon.brosdcast.qata... |
I I I " 676 TE free of 6.79TB

@ OneDrive

4, Double click the mapped network user shortcut in the desktop. For example, the
image shows the news6 mapped network user shortcut.

Please save your project and all associated files to your folder in Isilon.
All locally stored files will be permanently removed after each use.

Any technical difficulties?
Reporting an issue with the device or the room?
Please email
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5. Open the “iPhone Videos” folder

newsf
@ New - a6 (] E0 o N sort - = View - .-
. l 5> Metwork » newslocalisilon.broadcast.qatar.private > News > Users > newsf > v CTI £ Search newss
Name Date modified Type Size
v Quick access
Adobe Media Cache 2/26/2020 1112 PM File folder
&M Desktop »
Adobe Projects 10:49 AM File folder
b Downloads  #
AFP & Reuters File folder
= Documents  #
Audic File folder
P Pictures »
| iPhone videos File folder 1
Adobe Projects
P2 Content File folder
Reuters
Reuters File folder
VIDEOWALL_IMAC
Still Images File folder
Windows11-Deskt o
Newsroom Workflow Guide_Fall 2021_V2.... 9/19/2021 3:04 PM Adobe Acrobat D... 8,926 KB

6. Create a new Folder in the “iPhone Videos” folder with the title of your project

and the date. i.e., “Project Name 09-aug-2022"

L Downloads  #
= Documents 4

PN Pictures »

iPhone Videos
@ New ~ & (0] = w N sort = view -
R > v > Network > news.localisilon.broadcast.qatar.private > News > Users > newsé > iPhoneVideos > v G 2 Search iPhone Videos
Name Date modified Type Size
v Quick access
[ News-Rushes-9-aug-2022 8/9/2022 10:36 AM File folder ]
[ Desktop »

7. Copy the desired files from your smartphone to your newly created project

folderi.e., “Project Name 09-aug-2022"

Name

A MG1TTEMOV

Tpe

MOV Video File (VLC)

Name

A MGTTEMOV

Date modified

8/9/2022 10:59 AM

Tpe

MOV Video File (V.

A FZOz6308MPA MPa Vides
[£] IMG_1776.0G PG File
5] IMG_1772.0G PG File
5] IMG_1775.0G PG File
(8 M6_1774.06 PG File ( Users folder in Newsroom workstation ]
(<] MG_1772.pG PG File
VIDEOWALL IMAG VIDEOWALL IMAG
(8] YHI25500PG JPG File
Windows11-Deskt indows11-Deskts
rior TP @) xaquosazp PG File WindowsT1-Deskt
> @ OneDrive (8] MISX9703.0PG JPG File > @ OneDrive
> W spC [8) MsLv3326.p6 G File > B TR
[&] MORB6000.IPG PG File
> 8 Network > & Network
[£] JRC043020pG G File

News-Rushes-9-aug-2022
@new- ¥ O B W MNser = vew @new- ¥ O @ B W Mser = vew
<« Internal Storage > DCIM > 202208_ <« BN <« Users > news6 > iPhoneVideos > News-Rushes-3-aug-2022 Search News-Rushes-9-aug-2022

8. EjectyouriPhone from the computer, this will ensure that you are no longer
editing with the media directly from your iPhone
9. Double click adobe premiere pro desktop shortcut
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10. Navigatetothe Media Browser window and under Favorites locate:
e iPhone Videos -> “newly created project folder”
e Right click on the videos and click Import

TIPPOPEER: FoB-R

Exporting video to EVS using Adobe Premiere Pro
e Frist double click the video
e Next, drag the video to the timeline window

i Clip Sequence Markers Graphics View Window Help

e > o> oo Ad oo &

10



Northwestern | QATAR

Production and Digital
Media Services

11. If prompted with Clip Mismatch Warning, click on Keep existing settings.

Clip Mismatch Warning et

Eeep existing settings

12. Click on Window -> Extensions -> Export Sequence to EVS from the toolbar.

13. Set the following parameters on the Export pane
e Export Profile - To Playback + EVSX3
e Source range — Entire sequence or IN/OUT if marked
e Name* - Project name
e All other fields are auto filled
e Finally click on Export

11
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Export Sequence to EVS X

Export Profile To Playback + EVSXS3

Xsquare Target Playback + EVSXS03

Sequence Default Sequence
Start timecode 00:00:00:00
Source range Entire sequence

Duration 00:00:07:00

Name* iphone rushes 3 mar 2020

Var ID* iphone rushes 3 mar 2020

Keyword 1

B Qverwrite (Based on VariD)

Queue  Export Cancel

14. Click on IPLink Monitoring tab in the preview window and make sure a green tick
with a Successful status appears

Now the video is ready for use in ENPS rundown

In case of errors in export, reach out to production@gatar.northwestern.edu

12
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From Reuters news agency

1. Open google chrome web browser by clicking the Google Chrome icon in the
taskbar

2. The custom tab set to https://www.reutersconnect.com/all will appear

a X
&% Reuters Connect x +
O O (R * B @ :
i Apps Reuters Connect

REUTERS connecT  Feed Planning Live  Producti te 207  Nugreuters v

Search keyword SHORTCUTS +

\
- e ¥ .
Trending e, B Story Clusters | All Multimedia

VIEWALL > VIEWALL > VIEWALL >

Reuters News

ri Lanka president ¢ T = f Lo South Korean soldiers Sports stadium that Medical personnel ir A demonstrator atte

User Generated Content

7 ® Chat withus

If prompted for a username and password use the following credentials:
Login: nuq.reuters
Password: Password123

3. Click on Feed and then Video

Planning  Lve  Produ e 5 07 Nugreuters v

Search keywor ( SHORTCUTS v

g

EARLY ACCESS SCRIPT
Video will be svailable shortly

Migrants camp on beach as Migrantes africancs a la espera Two people killed, around 40 30 et CVCTS: NDeMbepa Rosario Dawson's Ufe began
tensions high on Greece's de cruzar 3 la isla ariega de bulldings destroyed by MIO3UKCNA N0 MOTHEAM imitating art after Briarpatch
Leshos Leshas
] ]
======= am = [

apartment ledge after be Downing Street parliament, elections set for ‘rude and arrogant’ online classes amid virus- Who shreds at the skatepark -
April induced school closure in full uniform

13
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4. Select the desired video to download by clicking on the thumbnail
[Alternatively, you can type in Search box to get the desired content]

i REUTERS cowwicT  Feed  Planning  Live  Productwity Suite [Beta]

GP race in Gatar
virus
Motoz and Moto3

US, Afghanistan's Talloan sign Sabalenka topples Kvitova to
peace deal in Dana claim Doha crovmn

gime’s aggression in TENNIS: WTA Doha: Coronavirus cases spread Taliban, U.S. welcome
dlib must be stopped Sabalenia bt Kuitova across the globe historic" troop withdrawal
immediately - Turkish FM cieal

reign minister calls
triot missiles as

Note: Some videos will not be available for download due to geographical and copyright
limitations. Ideally, look for RAW footages to avoid any such limitations or use the “MY
SUBSCRIPTION” filter.

5. Click on “Download HD 50FPS (MP4)”

qatar ) SHORTCUTS v
Emat Nt st eauerey +] © TN - ... |
L4 a & 4 v

» MotoGP™ &
%“' Unfortunately, due to travel restrictions, the t class is cancelled for

the ]

and #M will go ahead

[T

02/03/2020 01:58

6. The video will be downloaded to the “AFP & Reuters” folder of the respective
user.

14
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From AFP news agency

1. Open google chrome web browser by clicking the Google Chrome icon in the
taskbar

2. The custom tab set to https://news.afp.com/ will appear

@ AFPNews x4
<« C @ newsafp.com/#/c/main/actu/all
@ AnindGupt: [T Free Powerpoint Br.. % Compress POF onli..  #% QNBQatar-Home @ homevireless @) Earlyleaming toys @ A Guide to Commo.. [ Inside NU-

AGENDA SPOTLIGHT PARTNERS 9 AFPTVLive ﬁl

EN v Enter your search terms in English

m ARTICLES ~ PHOTOS  VIDEOS  GRAPHICS  PACKAGES

Filterby:  Languages v Topics v Locations v
TODAY, AUGUST 8, 2022
09:25AM LEAD Paris, France
Veolia va céder les activités de déchets de Suez au Royaume-Uni pour 2,4 mds EUR 383 words
09:25 AM DKAHA
bangladesh - dhaka - china - wang yi - fm - talks 44words

DKAHA, Aug. 8, 2022 (Xinhua) - Chinese State Councilor and Foreign Minister Wang Yi holds
talks with Bangladeshi Foreign Minister A. K. Abdul Momen in Dhaka, Bangladesh, Aug. 7,

2022. PACKAGE | 3
) | PICTURES OF THE WEEK (30 JULY-5 AUGUST)
0923AM NOTA-CENTRAL Matanzas, Cuba
Colapsa un tercer tanque petrolero en grave incendio en Cuba 759 words
09:224M Ksln, Deutschland
SID-TAGESVORSCHAU VIDEO fiir MONTAG, 8. August 205 words
09:22AM Washington, USA E ’
Biden bringt groRes Klimapaket durch den US-Senat ¥ pACKAGE ‘MfJ.
Der US-Senat hat ein milli i iedet. Es gilt als CHILDREN AMONG 41 DEAD IN GAZA AMID ISRAEL TRUCE
wichtiger Sieg fiir US-Président Joe Biden, der die bei seinem Antsantritt versprochenen REPORTS 3 :

groRen Reformen bisher nicht liefern konnte. 370 Milliarden Dollar sollen nun in den... S

09:21AM [TREI PROGRAM Paris, France
ttpe/news afp com/#/c/main/actu/s) 10tography 102words

If prompted for a username and password use the following credentials:

Login: prodeng-alerts@dqatar.northwestern.edu
Password: Password123

3. Once logged in to the AFP Forum website, insert the search criteria:
4. You can refine your search by using the below options.

NEWS AGENDA SPOTLIGHT PARTNERS 29 AFPTVLI NEWS AGENDA SPOTLIGHT PARTNERS LI AFPTV Live
ter your search terms in English ENTER YOUR SEARCH enter your search terms in English
CRITERIA
ES  PHOTOS VIDEOS GRAPHICS  PACKAGES
5 PHOTOS VIDEOS GRAPHICS PACKAGES FILTERS TO REFINE YOUR
. . SEARCH
ages v Topics v Locations
ges v Topics v Locations
52022
2022
aricLe [N Tokyo, Japan
LEAD Tokyo, Japan Japan's SoftBank reports Q1 net loss of $23.4 bn 320 words
Japan's SoftBank reports Q1 net loss of $23.4 bn 320 words
ARTICLE Kéln, Deutschland
Kéln, Deutschland FuBball, Bundesliga, 2. Spieltag Tiwords
FuBball, Bundesliga, 2. Spieltag T1words
ALBUM Rummanah, Palestinia
Territories
ALBUM Rummanah, Palestini conflict-israel-palestinian
R . itori =
conflict-israel-palestinian egitr=s s
N = = +
e A + 106 photos
! 4 1 106 photos
< RAW Port Moresby, Papua N
PNG prime minister's party invited to form government Guinea
RAW Port Moresby, Papua . . . .
) = o Guinea The party of Papua New Guinea's prime minister is officially asked by the governor-general
PNG prime minister's party invited to form government toform anew government after snaring more seats than its rivals in violence-scarred
. L national elections. Prime Minister James Marape's party has won 36 seats so far in the...
The party of Papua New Guinea's prime minister is officially asked by the governor-general
toform a new government after snaring more seats than its rivals in violence-scarred
national elections. Prime Minister James Marape's party has won 36 seats so far in the...

15
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5 Once the video content is identified, click the “Download” icon below the
corresponding content.

inoi Credits
Shinojleela |,
utc+s

AFP@ NEWS AGENDA SPOTLIGHT PARTNERS 1 AFPTVLive | Factcheck | @ Correspondent Al

VIDEO BACKGROUND ARTICLE Display more information

ID : http://doc.afp.com/32676Fs X AFP.

Raw A_SELECTED VIDEO
7/ =) DOWNLOD

BREBSTER

English x  Sport x

32G76F8
RAW-BRITAIN-FBL-PREMIER-LEAGUE-MANCITY

TITLE: PEP GUARDIOLA HAILS HAALAND AS HE GIVES MAN CITY DREAM START

AFP@ v

o E oo
about 9 hours ago L2

*Hehas incredible talerit™ Pap about 10 hours ago rn 20 ©)
Guardiola hails Haaland as-he gives "We should have done better': Man
Man'City dreamstart Utd manager afteropening day loss

DURATION: 02:20
PLACE: LONDON, UNITED KINGDOM

.

DATE: AUGUST 7, 2022

‘about 15 hours ago raw ‘20 August 7,2023 raw [Ty
Russian re-elected head of chess "When Messi smiles, team smiles,”
body FIDE, sees off Ukrainian: saysPSG'coach after 5-0 win-against
challenger Fe—

T B, P =i =
v > 2 i
o 'ﬁ‘ ( %‘ F“ -
August 6,2022 raw 56 Q) A < )
France: Barely back from his round- Rl raw (333, )

the-world trip; sailor dreams of new 'The marketis growing':People
horizons attend arms fairin southern Brazil

AUDIO: NAT SOUND, ENGLISH
SOURCE: PRESS ASSOCIATION
RESTRICTIONS: NO

CONTENT WARNING: NO

AUGUST 8,2022 - 12:37 AM DOWNL@AR spof
=~y fle [ ; — VIDEO
-5 & 'He has incredible talent': Pep Guardiola hails Haaland as he
% August 5,2022 RAW | 4:10 H e . oo oo

b ~ ol o
e o R a0s Q) Football: We'have to.prove onthe " Choose the formats to download A Download 1 file

'l could be that': Euro success pitch, says Barcelona's

6 The video will be downloaded to the “AFP & Reuters” folder of the
respective user.

Exporting video to EVS using Adobe Premiere Pro

1. Double click the Adobe Premiere Pro Default Project in the desktop

2. Navigatetothe Media Browser window and under Favorites locate:
e AFP & Reuters -> “the video file”
e Right-click the video file and select Import”

[

RN
*

16
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3. Double click the video and drag the video to the timeline window

LOCATION: Various

Duration: 1.08

Date Shot: March 1, 2020 / File
Natural / Mute

Restrictions: Broadcast: None
Digital: None

4. If prompted with Clip Mismatch Warning, click on Keep existing settings.

O match the

Eeep existing settings

5. Markthe IN and OUT from the timeline window as required

17
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Click on Window -> Extensions -> Export Sequence to EVS from the toolbar.

LOCATION:
Duration: 1.0
Date Sho
Natural /

Restrictions:

Set the following parameters on the Export pane

Export Profile - To Playback + EVSX3
Source range — Entire sequence or Sequence In/Out if marked
Name* - Project name or Story Name as instructed

All other fields are auto filled

Finally click on Export

Export Sequence to EVS

Export Profile

Xsquare Target

Sequence
Start timecode
Source range

Duration

Name*
Var ID*

Keyword 1

To Playback + EVSXS3

Playback + EVSXS03

Default Sequence
00:00:00:00
Sequence In/Out

00:00:25:01

CHINA HEALTH

CHINA HEALTH

B Overwrite (Based on VarlD)

Queue  Export

Cancel

18
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8. Click on IPLink Monitoring tab in the preview window and make sure a green tick
with a Successful status appears

Now the video is ready for use in ENPS rundown

In case of errors in export, reach out to production

19
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SECTION 04 — Ingesting images for Chyron graphics templates

Image download recommendation

Always choose a standard resolution image while using for the chyron templates.
One tip is to suffix 1920X1080 to the search.

This can help narrow down the search and find the image with the industry standard
resolution.

For instance, instead of typing Qatar Flag in the search engine, type Qatar Flag
1920X1080 to obtain a HD image

- o e
G qatar flag 1920X1080 - Google © X +

&« c O 8 google.com/search?q=gatar-+flag+1920X10808rlz=1C1GCEB_enQA882QA8828tsxsrf=ALeKk03YDwWFvKWL2FPoOvPa-a4PeAMVvAW: 1583323159836 &source=Inms&tbm=isch.. ¥ [ . H

HI Apps €} Reuters Connect

Go gEe [qalarﬂangoxmso (o ) QJ i °

Q Al @ images [ Videos [E News @ Maps } More Settings  Tools

u
g
i

a4

wallpaper background motion middle east background images waving wallpapersafari doha gatar hd wallpaper flag waving loop seamless >

Qatar flag asia wallpaper | 1920x1080 ... cool Qatar Flag Hd Wallpaper
wallpaperup.com pinterest.com

Save the image in the mapped network drive Z:
1. Right click and click Save image as

Qatar flag asia wallpaper | 1920x1080 cool Qatar Flag Hd Wallpaper 3
wallpaperup.com pinterest.com Openilink mnew ik

Open link in new window

Open link in incognito window
LB Send link to your devices >

Save link as...

Copy link address

Open image in new tab

Pinterest Save image as.. p|
Copy image
Flag of Qatar wallpaper | Qatar flag ... Qatar Flag Wallpapers on WallpaperSafari ; .
: f opy image address
pinterest.com wallpapersafari.com EIog Tt i arien| o a0 s

Search Google for image

Images may be subject to copyright. Learn more
B Adobe Acrobat »
Related images
Inspect Ctrl+ Shift+|
p M L

20
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2. Navigate to Z: mapped drive and open NEWS_IMAGES give it a logical name

and save

Qatar Flag Wallpapers - Top Free Qatar
wallpaperaccess.com

Qatar Flag Wallpapers on WallpaperSafari
wallpapersafari.com

VIDEOWALL_IM/
‘Windows11-Des

> @ OneDrive
> @ OneDrive

~ B This PC
> @l Deskiop
> & Documents
> | Downloads
> @ Music
> A Pictures
> £ Videos
> T 0S(C)

No items match your search.

Reuters Connect X | @ AFPNews X G qatarflag 1920x1080 - Google S X + =
<« C O @ googlecom/search?q=qatar+flag+1920x1080&riz=1C1GCEU_enQAB7IQABTIRisxsrf=ALICzsZCaBkiYGQ20RDTjcpvECQS-FMFpw: 1660115478777 &source=Inms&itbm=ischsa=Xewed=2.. 12 * % O @
Reuters Connect @) AFP News Other bookmarks
@ save As X
Go 9|€ qatarfiag 1920 ¢ v [ > ThisPC > Ingest Folders (\\camiodb) (Z) > NEWS_IMAGES v C I P Search NEWS_IMAGES (O ‘
Organize~  New folder = o
Reuters Name - Date modified Type Size

File name: [Qa(arrﬂagjpg I

Save as type: JPEG Image (*jpg)

A Hide Folders

Now the image is ready to be used in a Chyron template.
To use image as a graphics element in the ENPS rundown refer to section Adding

images to news graphics template

21
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SECTION 05- ENPS — Getting Started

Launching the ENPS application
1. Click on the AP|ENPS icon in the taskbar

Any technical difficulties?

Reporting an issue with the device or the room?
Please email

EOMeT OAl O m

2. A custom created ENPS window will appear

’ 7 ’, ’ = 1

s (=R

uuuuu o . ’ . ;. s , Ungroup  Her
s

‘‘‘‘‘‘‘‘

22
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Creating a new rundown in ENPS

1. Right click on the folder icon named HOLD Finals 2022 in the Navbar and select New

Rundown
- AR RBOmAS #D
- * a4 & .m%"ﬂ‘mrj‘j ~ 0

2. Select Fall 2022 from the rundown template and give a Title for the rundown.

T || [ |
. ) ™ )
|:: L= Search| | 1| ” = Search: | | | \|
\__F —
- 7

+ Basic Properties

Title Untitled

Rundown times

Start Time:
Select Rundown 81072022 [-][z0000em [7]
template as Fall End Time:
2022 | 8r0r2022 [=|[z000pm 2]
Duration:

\ 30:00

Rundown Template Blank Rundown

[ Blank Rundown |
Duration based  LFEIZ022 ]

onair | O

Rundawn Numeric Pages | [

Story Template

Program Name

Save Cancel

v Basic Properties

Tite | [Tuesday Bulletin ]

Rundown times

Start Time:

[ 8r10/2022 [-][¢0000pm [£]

End Time:

[ Name the rundown J

\ 8/10/2022 |- H 430:00 PM ‘ - ‘

Duration:
3000
Rundown Template Fall 2022 -
Story Template Blank Story v
Duration based
onair | O

Rundown Numeric Pages O

Program Name

Save Cancel

Inserting rows in ENPS rundown

1. Select the Row from the rundown where the new row is desired [The new row will be
inserted before the selected row]

2. Select Rundown tab from the ribbon

3. Select Insert Row

) S S

e e <
@ crenuT A B Us-
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Writing and editing a story in ENPS rundown

1. Double click on the segment that you want to edit
2. Write or edit your story in the script pane

o x

Production Archive

Q - 10:08:36 AM

69 (HEALTH) AP-BC.US--Election.
Warens future ncertan st oz n
Home state of Moss Eds: UPDATES.

oo o5 (g ©) -

@ AT AP-0C D
Sendey, el e Trbaruohes o
Pt 135134 Eos PORTES. Wi

1) (HEALTH) AP-BC.US Virus..
Fed Powel fces a pusling s it
o simpe soltion By CHRISTOPHER..

13 (HEALTH) AP-BC.USVirus.
* Feats Powel faces a puzling s it
e smple slation By CHRISTOPHER

49 (HEALTHD AP-5C-US-MED-—ADHD-.
ADAD cisgnoses ncresin n ek
s, report suggests Ed: PDATES

) HEALTH) AP.BC.US.-Virus..
San Antrio:COX planedito drop
e passengers at mall s

69 (HEALTH) AP-BC HIN.-Predators-.
Flascore in St sright game oz W
beat Predators 31 s UPDATES vl

49 HEALTH AP-5C-US--Flection..
st 4 VoteCas st cars

= = P Bl
& 30 o mn
Fom et Compat Fina Spaies
w  Gnd Gnd P
Eew e «
sogmont | sncnc
£ nevs1 D ine| 020027 it
£ rewst A0 | 030027 Pt
o CEECET o ) nevst o] 030027710
oo o T 01 Joovst Aoime] cso02re
o (] £ newst A0 ne| 030027 it
3 [news1 AD me| 030027 M1
T nevst A0 ne] 020027 Pt
] [news1 AD mg| 030027 P
Under 3000
X3 STORY 1INTRO Tuesey Busn)™ x Z0li-
Rundown: Tuesday Bulletin [3/3/2020 4:00 PM] Modified by: news1 AD Import  3/3/2020 3:00 PM  From: Class 2020 Word Count:10  [TL0:03] C
This s vhere you can wteor e your r. -
9
3 Wire Alets «

=1
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Adding video packages to the story using EVS MOS
1. Refer SECTION 03 to make videos available for your story in ENPS

2. Open the story that you want to add video packages
3. Locate the MOS icon in the Navbar

e

o a8 0 B DMA M ST — [

5. The EVS window will appear with all the video packages in its database.
6. Use the Search pane to locate the file that was ingested by Name. In this case
searching by the name Qatar brought the below mentioned results.

Note: The search is NOT case-sensitive

S
Q- 10:41:55AM

25



Northwestern | QATAR
Production and Digital

Media Services
Quality check the video package and drag it to your story

Double click the package and the EVS player opens with the package. Play the clip and check
if the package is as intended.

AP ENPS 800240 o
Home| B Player - o x| Q - 10:50:46 AM

< 8
<

Ungroup _ Hide
Tabs Notifications

13:42:48:15

Duration
12:50:00:00 o1:20:00:00

01/01/0001 PAL 01/01/0001

LsmiD  TapelD VarlD UmiD

=2 2 44 0 na DA G ¥ L]

Left click the desired video package and drag it to the story pane

o — 5 %
[ — Q- 404910 AM
T O [H[%m- o
¥DI . 2| 0 < &
o Brusm woA SA® 6 D@ wwoe o ol srae | semi
" [
N Mesges <« o)

w
30027 P10

HEBEEER
El

EREEIEEN ¢ E
‘H_\.!_H'!_\‘!_\T

030027 P

Modified by: news1 AD Import. 3/4/2020 10:12 &M from: Class 2020

Press “CTRL+S” to save the story

Note: Always remember to save the story before publishing. Failing to do so will render the story null.
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Adding news graphics [Lower thirds, OTS, Full Frame] to the story using Chyron CAMIO Plugin

1. Open the story that you want to add graphics.

2. Locate the MOS icon from the Navbar and left click or right click and select CAMIO.

I Settings...
1. Right Click on MOS icon MOS FTP Status
Set default media control 3
2. Select CAMIO to open EVS Main
Graphics plugin AP Video Hub
NUC Website
1 CAMIO ety 2.
- _ Y l@ Open default (CAMIO)
® 4 & & RS QXA O VST
3. If asked for username type “admin” and click the login button.
& camio
1. Enter LUCI Login
Username as
2. Click Login Login
® 4 & 2 OGS QA0

4. Choose the desired template from the Context drop down menu by selecting

Updated NWQ.

& camio

Filter: None W || Sort: A-Z w

dated NWQ v 1

=

Category: Show all

—

" BREAKING
NEWS

ngg',‘:‘;d Breaking < FsBoxes2 < FsBoxes3 v FsBoxes4 v FsBuisnessWea... © FsBullets <

O

9 LUC

FsBulletsEntert... © FsComingUp v}

Automation

Studio Clips

NORTH WESTERN

FsDefault

v

FsHeadshots1

Q

FsHeadshots2

FsHeadshots3 @

FsHeadshots4 @

FsInterstitial

<

FsMediaBox

v}

FsQuote 7

27



Northwestern | QATAR

Production and Digital
Media Services

Double click the desired template. For instance, choose Lower Third, fill the text contents,
and make sure the Channel and Layer is selected as 1 according to the below picture

Channels:

3A: for Lower Third Graphics

3B: for Full screen Graphics

4A: for Soft Set Graphics

4B: for News Desk screen Graphics
4C: for Videowall Graphics

4D: for Social Media Graphics

& CAMIO
L30neLine
TabTxt Text
Topic Tab P
TabTxt Text
FILL IN THE
Topic Tab P
DETAILS
BodyOneline Text
This is 3 main title with
campton Fant
CHANNEL.:

3A: for lower thirds

3B: for full frame graphics
4A: SOFT SET

4B: NEWS SET

4C: VIDEOWALL

4D: SOCIAL MEDIA

__ SewpAYER: 1
Layer D::
T

Out

5. After filling in the details, selecting the channel and layer, click on “Generate
Preview” icon to create the thumbnail

x

& Mo
L30neline Prime Styles: None v S Close Editor
iTabt Texk Generate Preview Q

Topic Tab 4

TabTxt Text S
Tope T ) <:| Details filled IN
BodyOneline Text

This is a main title with
campton Font

THIS IS AMAIN TITLE WITH CAMPTON FONT

Draq Ready!

e Channel selegigd.. siug 2 Nowh
LN 4 <= 1n| 00 |00 |{ 00 | 00 . Now the
= o0 ﬁ template is ready

(Drag Ready)

X :“ out| 00 300 00 00

Layer selected as 1

=

M 03N ¥E

»
aJ

6. Now the template is ready to be inserted in the required rundown story. Open the
story and drag the template onto the story window.
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) New Row 5 news? AD Import [test soft set run b 1x} & camio Ol ix
&  Rundown: test soft set rundowns [7/24/2022 2:00PM]  Modified by: news1 AD Impo.. Word Count:20 [TL0:07] (| L3Oneline Prime Styles: None v [SSlose Editor
= | TabTxtText
00010044(L30neLine) | 5 [ropicar ]
this is the story window, drag the graphics template over here once the grap ) TabTtTed
i b " q %
hics window shows as "Drag Ready’ 2, Story window | | e
e g 4
ready with the 3 "
template Q| BodyOnefine Text
prate. | [This is & main title with
©  |campton Font

c? 1

1. Drag the template from the template window to the story window

Drag Ready!
Channel Slug
i |
e pur 00 100 {00 {00
VA : out 00 500 {00 {00 &
a o, by a
o a4 2 QRGO AD ¥E (]

THIS IS AMAIN TITLE WITH CAMPTON FONT

7. Press “CTRL+S” in keyboard to save the update in ENPS.

Adding images to news graphics template

Note: Before you begin, reach out to Production department at production

to know which Chyron graphics templates can accept images.

atar.northwestern.edu

1. Refer SECTION 04 to make images available for your story in ENPS

2. Follow till step 3 in Adding news graphics section

3. Select the desired graphics template to use the image in. For instance, double click

on FsWeatherMap template from the News templates.

& camio X
FsWeatherMap Prime Styles: Nene + | Close Editor
Header Text Image
this is a main title with
campton bold 4 THIS IS A MAIN TITLE WITH CAMPTON BOLD
SubHeader Text 1. Fill in the 3. Click on the Image &
second line tet with aklurat. details Headshot placeholder for ‘ ¥

Headshot 3 H & . &
HsFirstname Text selectlng the Images "F “' prfd
NAME = .
- 4 y g
HsLastname Text -
Sumame J
2. Make sure of
@the settings
Channel Timecade Slug
B v 1|00 [2 00 3 00 {00
Lyer Dur| 00 |4 00 {00 |3/ 00
1 M out| 00 |10 00 [¢00 &

4. Click on the Image & Headshot placeholder which will navigate to select Images
5. Choose the context as “News” or select “Show All”
6. Search for the name of the image that was ingested in SECTION 04
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| ¥ CAMIO x

)|| Context: Show all +

3. Select "Show All" to find your picture

Category: Show all w || Flter: None w || Sort: Most Recent v

football

Headshot sam.. ©

News/Images/

weather icons__ @

%206/

weather icons_

weather icons_. @ weathericons_. )  weather icons_

©  weather icons_

weather icons_.

-Q  weather icons_.. ¢

weather icons_._ ¢

Westher/Images/ Westher/Images/ Westher/Images/

Headshot image
example

weather icons_..©  weather icons_ weather icons_

Weather/Images/

Lslal/\

Weather/Images/

ry

Cloudy
Weather/Images/

Weather/Images/ Weather/Images/

201074k-2163.. ©

animalsl @ A
Newe/lmages, VideoWall/images/ 1. Click Orj
placehold
Images to

Image
i
Headshot
the Image
rs for adding
t

Weathigamanes/ Westher/Images/ Westher/Images/ Westher/Imag ; Westher/Images/
2. Select the required J
image to fill in to the P
I humidity icon
template Weather/images/
»
- - &
=8 animals3 animals3 @
A E animals1
animalVoting  ©  Qatar/Images/ Qatar/
rdssind dind Qatar/Images/
HOLDFinisZD’ED

® A A Lo 0BAG FO

7. Selected image/images will then update on the relevant fields as shown below, close

the image selection window (or double click on the image) once its updated.

| ¥ CAMIO %

Selected Image

U‘dates

weather icons._...

weather icons_..»  weather icons_.. @ weathericons_.. @  weathericons_.. %  weathericons_..Q  weathericons_.. ©

Weather/Images/

weather icons_ weather icons_..
Weather/Images/ Weather/Images/

Weather/Images/ Westher/Images/ Weather/Images/

Weather/Images/

Selected
Headshot Image
updated

™

Westher/Imzges/ Weather/Images/

Headshot sam... ©

News/Images/

&g

weather icons_. @ weather icons_ weather icons_.. &
Weather/Images/ Weather/Images/ Weather/Images/

animals3 animals3 o
animals1

Qatar/Images/ Qatar/
Qatar/Images/

i
A 2c1074k-2163. ©
Cloudy @  News/Images/
Weather/Images/

animals1
videowall/Images/

humumty icon @

Weather/Images/

animalVoting ~ ©

close the image selection window once done..

8. Click on “Generate Preview” icon to create the thumbnail.
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¥ CAMIO
FsWeatherMap

Header Text

this is a main title with
campton bold 2

SubHeader Text

second line text with akkurat
pro

HsFirstname Text
NAME

HsLastname Text
Surname

Channel Timecode

Layer

B v In| 00 ;|00 ff 00 |00
Dur| 00 500 1 00 [:) 00
out| 00 2|00 [ 0o |00

is
th
ic

Prime Styles: None ¥

Close Editor

Generate Preview  [8)
ce the image selection
done for all fields, click

e "Generate Preview"
n

THIS IS A MAIN TITLE WITH CAMBTON |

e

9. Thumbnail creates and “Drag Ready” message appears which means the template is
ready to be inserted in ENPS

¥ CAMIO
FsWeatherMap

Header Text

this is 3 main title with
campton bold A
SubHeader Text

second line text with akkurat
pro

HsFirstname Text

NAME

HsLastname Text

Sumame

=’

Headshot
x

B, -

;v‘l

i

Prime Styles: None

Drag Ready!

x

Close Editor

10. Now drag the template preview to the relevant story and hit “CTRL+S” to save the

update in ENPS.
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72 test camio 18th July [T

Pag| | Story Siug

o0 "l %

Segment  [A

L3 template1 [test camio 18th July]*

| [Under 29:56

& Rundown: test camio 18th July [7/18/2 PM] Modified by: System Administrator 7/18/2022 5:19 PM  From: Class 2020 [TL0:01] [‘
test for template 1
L 3. Save the story (CTRL+S) to -
00010575 E
update &
1. Drag the ps)
2. Story with o template to the g
= template elevant story
& camio - x
FsWeatherMap Prime Styles: None v Close Editor
Header Text
MAIN TITLE y
SubHeader Text
second line text p
HsFirstname Text
MNAME y
HsLastname Text
Surname p
Sikane
Drag Ready!
Channel Timecode Slug
3B - In| 00 100 |2 00 2|00
Fawary pur| 00 100 [ 00 {00
1 v )

©Out| 00 [# 00 |3 00 [f 00

Saving the story in ENPS
1. Click in the story pane and hold CTRL+S to save the story
2. The row and the slug will flash orange three times indicating the save
3. Inturn, the orange bar in the segment will turn Red indicating the same

o
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Note: Always remember to save the story before publishin

. Failing to do so will render the story null.
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Publishing the rundown in ENPS

1. Click the rundown tab of the rundown that needs to be published

=
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2. Locate and select the Production tab in the top ribbon
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3. Click MOS Story Send, tick NCR, and Save
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Document repository

The document is available in Isilon central storage and in the desktop of all the newsroom machines
when logged in as a news user.

Desktop

Please save your project and all associated files to your folder in Isilon.

All locally stored files will be permanently removed after each use.

Any technical difficulties?
Reporting an issue with the device or the room?
Please email

Isilon

To access in windows:
\\news.localisilon.broadcast.qatar.private\Users\Newsroom_Workflow_Guide_Fall 2022_V1.pdf

To access in mac:

smb: //news.localisilon.broadcast.qatar.private/Users/Newsroom_Workflow_Guide_Fall
2022_V1.pdf

Support

For any technical and operation support, email Production helpdesk at

production@gatar.northwestern.edu
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